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Note: Online proctoring is no longer available as a standard exam option. This manual provides information
about Proctorio for online proctoring which is still being used for students dealing with long-term special
circumstances, as a result of which they are unable to take a test at the HU, who can submit a request to the

Examination Board for taking a test via online proctoring at a location other than the HU (as a possible
solution).

Are you experiencing problems during your exam?

[ Click here}for FAQs about technical faults or go tg page 10



https://husite.nl/digitalehu2/en/distance-education/f-a-q-digital-exams/

Online proctoring

Everything about exams by means of proctoring
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General:

What is proctoring, what is Proctorio and when is
it used?

Proctoring is remote digital invigilation. This can be achieved in different ways using different
software. This manual specifically deals with the Proctorio software, used in combination with an
exam via the TestVision exam application. HU University of Applied Sciences Utrecht selected the
proctoring system of Proctorio.

This Proctorio software also works with automated review support and stores images among other
things. This means that reviewers are not watching what you are doing in real time, they will
retrospectively only review moments at which the software detected ‘abnormal behaviour’. In
configuring the software, abnormal behaviour will be pre-defined for each exam. For example, is the
student allowed to use reference works during the exam or start other software? An example of
abnormal behaviour is when the student walks away or looks away or when somebody else is seen in
the room. The reviewer will receive notification via a report which is automatically generated on the
basis of behaviour that has been defined in advance as ‘abnormal’. The reviewer can watch those
specific incidents and decide whether there is reason to ‘suspect irregularities’. For example, this will
prevent drinking a glass of water from being seen as a case of ‘suspect irregularities’. The proctoring
data (such as the images) will be retained for a month, they are encrypted and are not seen by the
supplier and its employees. These are subsequently automatically deleted, unless the Examination
Board needs more time to see the footage because of a suspicion of irregularities.

Proctorio is software that:

e Can record things during the exam, such as webcam images, your screen itself and sounds.

e Detects eye movements to see if you look away from your screen. Analyses the manner in
which you use the keyboard, so as to check that the exam is being sat by you.

e Ensures that we can check that you are who you say you are, by recording proof of ID and by
having you take a picture of yourself*. It is also possible that you are asked to make a room
scan, so that you can prove that there are no unauthorized items in your environment.

e Ensures that you cannot do certain things during the exam, such as opening new tabs or
printing (this depends on the actual exam).

e Provides access to a number of tools during the exam, for example a calculator. Again, this
depends on the exam settings set by your lecturer.



Prevent study delay

HU University of Applied Sciences Utrecht sets great store by your privacy and the ethical aspects with
regard to proctoring. It goes without saying that we have done our utmost to limit the risks with respect
to your privacy. Proctoring is a last resort, when no alternatives can be found for a specific exam. The
decision to go for proctoring was made to prevent the situation where many students would fall behind
in their studies. The situation was considered from various perspectives: the student, examiner,
invigilator/reviewer, organization, degree programme (managers) and support services, also in respect
of multiple values: equal treatment, well-being, reputation, autonomy, privacy, study progress and
success, and reliability. We recognize that not everyone is capable of participating in this kind of
examination, we are looking for support and alternatives for those people.

A few facts about the use of Proctorio by HU University of Applied Sciences
Utrecht

e The system itself can only “mark” moments of abnormal behaviour, the software does not
actually make any judgments. If the software detects behaviour that might be abnormal, the
moments marked by the system as abnormal behaviour can be assessed by a reviewer. A
reviewer is usually a lecturer in your degree programme. If the reviewer qualifies marked
behaviour as a suspicion of irregularities and forwards it to the Examination Board, then one
of the members of the Examination Board may also access the proctoring data (including the
footage). The Examination Board will mount a thorough investigation in which of course each
party will be able to put forward its point of view.

e Do not worry, you will not be branded a cheat just like that. We are aware of the fact that
many students are worried that the software will wrongly label them as ‘cheats’. The fact is
that the software does not detect fraud, the footage with conspicuous behaviour will be
watched by HU staff members. And you will not immediately be branded a fraud if you just
look away briefly to think for a moment! The best thing to do is to behave in a way during the
exam as you would normally do during any other exam. Therefore, just try to focus on the
contents of your exam. A neighbour ringing your doorbell and you looking away from your
screen momentarily, or your little sister walking into the room and you sending her
immediately on her way again are obviously not cases of fraud.

o The footage is not sold to or seen by third parties. Only designated staff members of the HU
will see this footage. If there is no reason to investigate further, the footage will automatically
be removed after a month.



More information about the use of proctoring software at home: your rights
and obligations

Questions or more information about privacy?
Read the FAQs and the Privacy Statement on Digital HU or email your question to askprivacy@hu.nl.

Is there an alternative if | object to the processing of my personal data?

First of all, we will ask you to read the entire Privacy Statement and the FAQs on Digital HU.

If your concerns or comment are then not sufficiently addressed, or if you have any objections, please
send an email to that effect to askprivacy@hu.nl. For personal or confidential questions, you can
contact the Data Protection Officer: roos.roodnat@hu.nl.

Is there an alternative if | object for other reasons/principles?
Send your request to the relevant Examination Board via http://HUKAS.hu.nl.

What if from a technical point of view | do not have the opportunity to take part in one of these
exams? Requesting a HU loan lap top:

Are you (currently) without your own (suitable) laptop? First of all, we will ask you to do your best and
to look for alternatives in your surroundings. If such alternatives are absent, please contact the
relevant Examination Board via http://HUKAS.hu.nl for a possible substitute arrangement.

Do you have questions or are you concerned about (incorrectly marked sections that could be
construed as) fraud?
Read the FAQs, you can find them on Digital HU.

Would you like to know more about Proctorio?
Please visit https://proctorio.com.

Do you have a problem with your HU account, for example because you have forgotten your
password?

Visit https://inloggen.hu.nl/smsstartpage/. For other questions about your account, please call the
Help Desk: 088-481-6666 Option 5, available between 08:00 - 17:00 local time
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In advance (+/- 3 weeks to 1 week before exam):

General preparation

If you want to be sure that you are not going to be unpleasantly surprised at the start of your
proctored exam, we advise you to check the following points about one week before the exam:

1;

Please read this entire instruction carefully

If you have any queries, comments or objections after reading this instruction, please follow the steps
that apply to you, which can be found in ‘More information about the use of proctoring software at
home: your rights and obligations’ on page 5 of this manual. You can also read the Privacy Notice.

Find yourself a quiet, well-lit room with stable internet connection
If possible, use a network cable. Make sure your face will be well lit, so the camera can see your face
clearly. Also make sure your clothing or hair doesn’t block your face.

Get yourself a properly working laptop or PC

Make sure you have a properly working laptop or PC, but we would prefer you not to use a Chromebook.
Check whether the webcam and microphone are in good working order. You can use Windows or Mac.
If that doesn’t work, Follow the steps in ‘More information about the use of proctoring software at
home: your rights and obligations’ on page 5 of this manual.

Limited help or support is available from the help desk (088-481-6666 Option 5, between 08:00 - 17:00),
the reason being that your PCis not a device issued by the HU. Make sure you have first carried out tests
to the best of your ability, or have tried to borrow a laptop, before you contact the help desk.

Make sure you have a valid proof of ID at hand

You will be asked to show your (valid!) proof of ID. A student card is not a valid form of ID! Make sure
the citizen service number (BSN) is not visible, you can do that by masking it with tape or by crossing it
out with a dark ink marker pen (NOT waterproof). You will find this number on the back of a driving
licence or identity card. On a passport, it can be found on the front and the back (it may be incorporated
into a longer code). See ‘OER’ on wegwijs.hu.nl for information about what constitutes a valid ID.

Install MS Edge or the Chrome as the browser

If you don’t have Edge or Google Chrome installed on the device yet, please install it now. The exam
will be administered via one of these browsers. If you are about to start a (test) exam, Proctorio will
ask you to download the plug-in and to install it. A plug-in is an extension of the possibilities of your
browser. Instructions for the installation of the plug-in can be found in Appendix 1.

(Where applicable) Check your facilities for unimpeded study

There are limited facilities for tests that are subject to proctoring. Have you been assigned a facility by
the Examination Board and do you wish to use it during the exam? Read the section on ‘Facilities’ on
page 9.

If possible, take a trial test with Proctorio
You will be taken through the Proctorio system check and you can ask your questions in time.



Before the exam (+/- 1 hour before start):

Step 1: General checks

To ensure you are ready to start with your exam, check the following things:

1;

2;

Ask your housemates or flatmates to be considerate during your exam
Agree that the use of shared Internet data is minimized.

Make sure you are alone, in a quiet environment where you cannot be interrupted

at the drop of a hat
Sounds like music or television are not allowed. A small amount of ambient noise, for example a scooter
passing by outside, is no problem.

Keep your (valid!) proof of ID at hand for verification and make sure you know your

HU email address and password. A student card is not a valid form of ID!

Make sure the citizen service number (BSN) is not visible, you can do that by masking it with tape or
by crossing it out with a dark ink marker pen (NOT waterproof). You will find this number on the back
of a driving licence or identity card. On a passport, it can be found on the front and the back (it may be
incorporated into a longer code). See ‘OER’ on wegwijs.hu.nl for information about what constitutes a
valid ID.

Make sure that your desk/environment is empty and your face is clearly visible
Apart from your laptop/pc, you are only allowed to have things (books, scrap paper, calculator and so
on) on your desk or use these when prior to the test or in the introductory text this has explicitly been
permitted. In other words, this may change from exam to exam. No earphones, headphones and no
smart phone. Also take off your cap or any other headwear. You are allowed to have bottled water on
your desk. Make sure your desk and immediate environment are clearly in view if a room scan has to be
made. Make sure your face will be well lit, so the camera can see your face clearly. Also make sure your
clothing or hair doesn’t block your face.

Make sure that no personal information can be displayed on screen that you do not
wish to be recorded

This also applies to your monitor. Ensure that you are comfortable with what may come into view. Be
aware that you may have to make a scan of your environment with your laptop before you start.

Take off your glasses for the ID check
The system works best when you remove your glasses for the ID check. Afterwards, you may then of
course put your glasses on again for the exam.

The area (floor, ceiling, desk etc.) around you must not contain written texts or crib

sheets (“cheat sheets”)
This is self-explanatory, unless there is an exception as referred to under point 4.

Do not press the ‘Stop screensharing’ button during the exam
If a pop-up dialogue appears with the prompt to stop screensharing, do not press ‘Stop screensharing’.
You can use the ‘Hide’ option though.

Make sure you have been to the toilet before you start.



Before the exam (+/- 1 hour before start):

Step 2: Technical checks

To make sure that you do not incur an unpleasant delay when you want to start with your exam,
because things are not working, check the following things before you start:

6;

Your camera is on and working

You can test this by going to https://www.onlinemictest.com/. Pay attention to this during the exam to
make sure that the camera keeps working. You can check this by looking at your camera image that
Proctorio always shows in the small screen that opens when you start. If the screen is black, please get
in touch, see ‘Technical fault or question during the exam?’ on page 10.

Your microphone on your device is working
You can test this by going to https://www.onlinemictest.com/.

Your device has enough power or is connected to the grid

Your Internet connection is working
If possible, use a network cable, Wi-Fi can be a bit unstable sometimes.

Make sure MS Edge or Chrome has been installed as the browser

Read what you must do in case of technical problems (page 10)

Proctorio will carry out part of these checks as well before you start with your exam. If you experience (technical)
problems in the days before your exam, follow the steps under ‘More information about the use of proctoring
software at home: your rights and obligations’ on page 5 of this manual. For communication immediately before
or during the exam, there are other channels, see ‘Technical fault or question during the exam?’ on page 10 of
this manual.
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Facilities

Facilities are available for taking an exam at home with proctoring. Below, you can see the facilities
in question.

e Extratime

e Concentration (earplugs)

e (ClaroRead*/Readspeaker (text-to-speech software)
e Medication

e Food

e Digital dictionary (downloaded before the exam)

The use of a facility will be discussed with a student counsellor and granted by the Examination
Board. In OSIRIS, you can see whether you have been granted a facility. Extra time will be
automatically set to On in TestVision if you have been granted this facility.

* ClaroRead can be downloaded free of charge via the following link:
https://wegwijs.hu.nl/support/study-optimally/request-extra-accommodations/claroread-reading-
software Note: in order to use ClaroRead, the facility must have been granted to you by the
Examination Board.



Technical fault or question during the exam?

Of course, it may happen that you find yourself unable to start Proctorio or your exam or that a fault
occurs halfway through the session. Don’t panic!

Click here|for a quick answer to your questions in the FAQs about technical faults or urgent
questions, or click below in the blue screen on the button to go to a live chat with Proctorio directly
(this works if the plug-in has been installed). The language used for this contact is English.

Chat support Proctorio

In the event of technical problems and questions regarding the use of Proctorio, please contact the
English-language chat support of Proctorio. Support is available in Google Chrome after the installation
of the Proctorio plug-in.

Start live support chat 2>

During the exam, you can directly access the Proctorio chat feature under your web cam image with Ea .

this button:

Is Proctorio chat support unable to help you?
In that case, please send an email to onlinetoetsing@hu.nl. This support
option is quickly available during your exam.

10
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Start exam:

Starting completing

Go to http://hu.testvision.nl/online/kandidaten
If Chrome is your default browser, this works immediately, otherwise you will first have to start
Chrome and paste this link.

Log in with your HU email address and your own password.

If you have forgotten your password: please go to https://inloggen.hu.nl/smsstartpage/ to
change your password.

Click on Toets Maken (Sit an exam).
As indicated under Technical checks, you will need the browser Chrome or Microsoft Edge to
start your exam. On entering the Proctorio environment for the first time, you will be asked to
download and install a plug-in (this will take a minute or two). If you want to know how to do
this, see Appendix 1. Make sure no other applications or Internet pages are open, they may
slow down the plug-in or cause it to crash.

Start the exam (click on the blue arrow next to the name of the exam).
The clock does not start running until you have started the exam. Please make sure that you
start on time after all (start of exam), as with some exams a limited start period has been set!

Go through the pre-exam checks of Proctorio.

When you have completed these checks, the Proctorio screen will open and your webcam is
switched on. Here you can open the live chat, or hide the camera by pressing the button
‘Collapse’. You can also drag this window to another place on the screen that is more
convenient for you.

® oquizTools

Standard Proctorio screen Collapsed Proctorio screen

Take the exam.

If the exam or the plug-in crashes or closes unexpectedly, close all web pages and log in
immediately afterwards. The clock is stopped for as long as you are not “in the loop” of the
exam. Please note that an end time has been set for the exam, so do not wait too long with
taking action.

Ready with the exam? Complete the exam and close your browser, that way
you will also close Proctorio.

Good luck!

11
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After the exam

e Do you have any content related questions or comments about the exam after you finished it?
Please ask your question in an email to your lecturer.

e Do you want to uninstall the software? See Appendix 2: Uninstalling Proctorio plug-in

e For technical questions or experiences that you want to share about the exam, please email
your question or comment to onlinetoetsing@hu.nl.

Do you have any other questions or objections? Follow the steps mentioned under ‘More information
about the use of proctoring software at home: your rights and obligations’ on page 5 of this manual.

12


mailto:onlinetoetsing@hu.nl

Appendix 1:
Downloading and installing Proctorio plug-in

A plug-in is an extension of the possibilities of your browser. You will need this plug-in to start your
proctored exam. The system requirements can be found at https://proctorio.com/support. This
manual is available in a version for Windows and a version for Mac.

-- For Windows users:

5;

Start TestVision in Chrome or MS Edge as your browser; if you do not have it yet, install it.
When you login to TestVision, click on ‘Toets maken’ (Sit an exam).

You will be taken to a screen where you can start your exam. Press on the arrow next to the
exam. You can see an example below:

@huni i U
Ed Toets maken i

Toetsnaam Az Begindatum/tijd Einddatumitijd

[proctor] Toets - summatief - geen open vragen 14.05-2020 00:00 20-05.2020 23:55 [ > I

If you use Chrome or MS Edge as your browser, you will be directed to the screen shown
below. Click on ‘Click here’ under ‘Install Proctorio Chrome Extension’.

Proctorio Chrome Extension

This course requires you to install an extension into your browser.

e ¢ ° Use Google Chrome.

done.

Install Proctorio Chrome Extension.
') ‘ click here

A second screen appears, click on ‘Add to Chrome’ here.

£~ chrome web store o

Home > Extensions > Proctorio

@ Froctoreo
Offered by: proctorio.com

13
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6; A pop-up screen prompts you to add the extension, click on ‘Extensie toevoegen’ (Add

7;

extension).

X

Wil je ‘Proctorio’ toevoegen? @

De app/extensie kan het volgende doen:

« Al je gegevens lezen en wijzigen op de websites die je
bezoekt

« Meldingen weergeven

+ Gegevens aanpassen die je kopieert en plakt
« De content van je scherm vastleggen

+ Je downloads beheren

« Opslagapparaten identificeren en verwijderen
« e apps, extensies en thema's beheren

« Je privacygerelateerde instellingen wijzigen

Extensie toevoegen ‘m‘

After a short installation, a message appears saying that the extension has been added.

)

. (.) Proctorio is toegevoegd aan Chrome.
e B B

Dit pictogram wordt weergegeven wanneer de
extensie een actie kan uitvoeren op de huidige
pagina.

Je kunt je extensies beheren door in het
gereedschapsmenu te klikken op 'Extensies’.

Remove from Chrome

It is possible that the extension has not been enabled by default. In Google Chrome go to
‘More tools’ to find and manage the extension.

You can now return to the TestVision screen. Proctorio will start with an introduction. Carry
out the pre-checks and start with your exam. Good luck!
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For Mac users:

4;

5;

6;

Start TestVision in the Google Chrome browser; if you do not have it yet, install it.

When you login to TestVision, click on ‘Toets maken’ (Sit an exam).

You will be taken to a screen where you can start your exam. Press on the arrow next to the

exam. You can see an example below:

@hu.nl I U
K4 Toets maken i

Toetsnaam Az Begindatum/tijd Einddatumitijd

[proctor] Toets - summatief - geen open vragen 14-05-2020 0000 20.05-2020 23:55 B

If Google Chrome is your default browser, you will be directed to the screen shown below.

Click on ‘Click here’ under ‘Install Proctorio Chrome Extension’.

Proctorio Chrome Extension

This course requires you to install an extension into your browser.

e+ ¢ a Use Google Chrome.

done.

Install Proctorio Chrome Extension.
‘ ‘ click here

A second screen appears, click on ‘Add to Chrome’ here.

£ chrome web store e

Home > Extensions > Proctorio

Proctorio

Offered by: proctario.com

’

A pop-up screen prompts you to add the extension, click on ‘Add extension’.

@ Add "Proctorio"?

It can:

Read and change all your data on the websites that you visit
Display notifications

Modify data that you copy and paste

Capture content of your screen

Manage your downloads

Cancel Add extension
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7; After a short installation, a message appears saying that the extension has been added. Click

on ‘Turn on sync’.

*~ @ o :

(.) Proctorio has been added to Chrome
s,

This icon will be visible when the extension can
act on the current page.

Manage your extensions by clicking Extensions in
the Window menu.

To get your extensions on all your computers, turn on
sync

X

Turn on sync...

8; Itis possible that the plug-in is not allowed for use by default. Go to Extension Management

in Google Chrome via ‘More Tools’.

sifrelated Yr

New Tab
New Window

New Incognito Window

History

Downloads

E Bookmarks

Zoom - 100% +
Print...
Cast...
. Find...
Save Page As... #S More Tools
r Create Shortcut... Edit Cut Copy
Clear Browsing Data... t8a Settings
Extensions Help
Task Manager
Developer Tools a8l Q
rome Lockdown I-Know ProctorExam Screen Sha...
s gk ok 3 * %k ok g 122 kK 20

>

®

@

8T

T8N

L
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9; When you have accessed Extension Management, you will see the Proctorio extension listed.
Click on ‘Details’. A screen will appear in which you can indicate when the Proctorio plug-in
must be allowed. Make sure that this option is set to ‘On all sites’.

Q, Search extensions

Version
1.4.20164.1

Size
12.2MB

Permissions

Read and change all your data on the websites that you visit
Display netifications

Modify data that you copy and paste

Capture content of your screen

Manage your downloads

Identify and eject storage devices

Manage your apps, extensions, and themes

Change your privacy-related settings

P T R R

Site access
Allow this extension to read and change all your data on websites that you visit: @

O onclick
O On specific sites

@® Onallsites

Allow in incognito
Warning: Google Chrome cannot prevent extensions from recording your browsing history. To disable
this extension in incognito mode, unselect this option.

Allow access to file URLs

10; You are now ready to begin. Log in again and start the exam. Proctorio will start with an
introduction. Carry out the pre-checks and start with your exam. Good luck! Is the plug-in still
blocked or are you stuck with a screen that takes a long time to load? If so, proceed to the
next step.

11; Itis possible that the plug-in is still blocked, this depends on the version of your 10S. If this is
the case, go to ‘Systeemvoorkeuren’ (‘System preferences’) under the Apple settings. Go to
‘Security and privacy’ (Beveiliging en privacy) and search for ‘Screenshot’ (Schermopname) in
the left-hand column.

® proctorio
Je volledige scherm delen
Je volledige scherm delen

Proctorio wil de content op je scherm delen. Kies wat je wilt delen

o Google Chrome wil het scherm van deze computer
vastleggen.

i_@ Geef deze app toegang via het paneel 'Beveiliging en
privacy' in Systeemvoorkeuren.

? Open Systeemvoorkeuren Weiger

Annuleren Delen
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12; Select the option Google Chrome to enable screenshots:

@ (_ ) ] _EEEE Beveiliging en privacy [Ql k ]

Algemeen FileVault  Firewall

Locatievoorzieningen Geef op welke van de onderstaande apps de inhoud
van je scherm mogen vastleggen, zelfs wanneer je
andere apps gebruikt.

Contactgegevens
ﬁ Agenda's . QuickTime Player
"; "‘.‘ Herinneringen ‘. Google Chrome
&] Foto's w Microsoft PowerPoint

u Camera m Microsoft Word

w Microfoon
W Spraakherkenning
Toegankelijkheid

~
E Klik op het hangslot om de instellingen te wijzigen.

13; At this point you must stop the Chrome session and start the program again.

Beveiliging en privacy Q, Z {

Je kunt ervoor kiezen om 'Google Chrome' nu te

Google Chrome kan de inhoud van je scherm
@ niet vastleggen tot je de app sluit. ‘

3 stoppen of het later zelf doen.

Locatie) +inhoud |
Later 1eer je |

‘ Contacl e geeeeem

@ Agenda's v . QuickTime Player

i\ Herinneringen v §® Google Chrome

(2| g ¢

& Foto's v m Microsoft PowerPoint

W Camera E' Microsoft Word

w Microfoon

w Spraakherkenning

Toegankelijkheid

g Klik op het hangslot om de instellingen te wijzigen.

14; Log in again and start the exam. Proctorio will start with an introduction. Carry out the pre-
checks and start with your exam.

Version: 25/08/2023
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Appendix 2:
Uninstalling Proctorio plug-in

If you do not need or wish to use the plug-in again, you can uninstall it after your exam(s).

1; Start Google Chrome.

2; On the right of the search bar you will see the logo of the Proctorio plug-in (an image of a
shield), and click on it. The following screen will be displayed, in which you need to select
‘Remove from Chrome...” (Verwijderen uit Chrome...).

Q W X

Proctorio

Verwijderen uit Chrome...

Verbergen in Chrome-menu

Extensies beheren

3; A pop-up will prompt you to uninstall Proctorio. If you click on ‘Remove’ (Verwijderen), the
plug-in will be uninstalled.

(.) Wil je 'Proctorio’ verwijderen?
iy,

Misbruik melden

o
B

Verwijderen Annuleren
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